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1. INSTALLATION 

1.1. Prerequisites 

Although best executed on Windows 7, WoundManagerTM could be installed and used on 

any Windows version from Windows XP with service pack 3 ahead. Since it is built to utilize 

all available system resources to speed up wound image analysis it is necessary to keep 

Windows updated with Automatic Update tool. 

WoundManagerTM requires following Microsoft components to be installed: 

 Microsoft .NET Framework 4 Client Profile 

 Microsoft SQL Server Compact 3.5 SP2 ENU 

If missing, these components will be automatically installed by the WoundManagerTM 

installer, but computer should be connected to the Internet for the installer to download 

required components. 

1.2. Installing the product 

Installation is contained within WMBasicxxx.exe self extracting archive, where “xxx” 

corresponds to the application version. It is necessary to download that file to local folder 

and double click it. 

After completion, WoundManagerTM icon  will be at the desktop and in Windows Start 

menu. Double click the icon to start the application. 

1.3. Location of application files 

WoundManagerTM will be installed in a folder C:\Program Files (x86)\WMBasic on Windows 

Vista and Windows 7, or C:\Program Files\WMBasic on Windows XP. 

In unhappy case that the application stops working, log file WMBasicLog.txt will be 

created at the user desktop.  

1.4. Location of database file 

Basic edition uses MS SQL Server 2008 R2 Compact Edition database, which resides on the 

same computer where application is installed and requires no special administration. Empty 

database is installed at the same location as the application. On first start it is copied to the 

application data folder. On Windows 7 it will be the folder 

C:\Users\[user_name]\AppData\Roaming\WoundManager. 
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1.5. Obtaining license 

WoundManagerTM will initially work as a demo version time limited to 45 days. To obtain 

valid license code it is necessary to purchase license and send hardware key to e-mail 

address WMregister@antonic.hr. Registration form will be displayed either automatically if 

demo expired or through the Help->Register menu. 

 

Request license button will create new e-mail in default e-mail client. Before sending It is 

necessary to fill all required information. Alternatively it is possible to manually compose e-

mail message (e.g. if webmail is used), copy and paste hardware key and add required 

information. 

Received license key should be copied to the form. Precaution is necessary not to copy 

surrounding text or omit some 

characters. 

It is always possible to check the 

license through the Help->About 

form, which displays copyright 

information, application and 

database version and licensing 

information: registered user and 

license expiration date. 

 

 

mailto:WMregister@antonic.hr
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1.6. Updating database 

WoundManagerTM version from 1.2 above requires database to be updated to version 1.2. 

Update process will be performed automatically upon starting the application. Backup of old 

database will be created in the database folder (see 1.4) and named 

“WMBasicDB_date_time.sdf”, where date and time are current date and time. 

Updating progress is displayed during the process. 
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2. USER INTERFACE 

User interface is organized around three sheets (tabs), corresponding to Patients, Wounds 

and Examinations. That organization reflects the database structure, which is organized 

around three corresponding main tables connected by “one to many” relationships. That 

means that each patient can have multiple wounds and each wound can have multiple 

associated examinations. 

Each main tab has an Overview sub-tab and eventually some more sub-tabs. Upper part of 

the Overview tab contains specific data (opened patient, wound or examination detailed 

information). Table at the lower part displays all related records (all patients, all wounds 

associated with selected patient, all examinations related to the selected wound). 

2.1. Menu bar 

Menu bar contains three command groups: File, Tools and Help. 

 

2.1.1. File menu 

Under File menu there are Save and Exit commands. Save performs same function as the 

Save toolbar icon and Save commands displayed on Patients, Wounds and Examinations 

tabs. Exit closes the application in the same way as pressing the Close button at window title 

bar. In case data are altered user will be prompted to save data. 

2.1.2. Tools menu 

Tools menu contains Options command, and commands to Backup and Restore the 

database. 

Options command opens form with two options. “Treat fibrin layer as separate tissue type” 

is used to determine whether three or four tissue types will be used during wound analysis 

(see 3.1.1). “Backup/restore folder” specifies location where database will be backed up to / 

restore from. 
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Backup command copies database file to the backup/restore folder defined in Options. If 

backup copy already exists it will be renamed to “WMBasicDB_yyyy-mm-ddThh_mm_ss.sdf”, 

where date and time corresponds to the database file modification time. Therefore, to 

restore previous version of the database it is necessary to change the name of selected file 

to “WMBasicDB.sdf” and perform restore. Excessive copies should be periodically removed 

from storage media to keep enough space for backup. If more than seven days passed since 

last backup warning will be displayed in Status bar. 

Restore command restores the database from the backup/restore folder defined in 

Options. Precaution should be taken because working database will be replaced 

with the backup database. This operation cannot be undone. 

Backup – restore sequence could be used to copy the database from one computer 

to another. 

 

2.1.3. Help menu 

Help menu has three commands, for displaying this instructions, information about the 

application and for registering WoundManagerTM (see 1.5). 

2.2. Tool bar 

Tool bar is positioned at the top of the main application window, just below the menu bar. It 

contains shortcuts to various commands, depending on context 

 

Save button ( ) commits all changes to the database. Print button ( ) generates 

preview of the report, which could be printed at any of the installed printers. Report format 
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depends on context. If patient is opened in Patients or Wounds tab, Patient report will be 

generated (see section 2.5). If particular examination is opened in Examinations tab, 

Examination report will be generated (see section 2.8). At the right side of the tool bar 

current patient is conveniently displayed. Help icon ( ) displays this instructions. 

For wound analysis, additional buttons are displayed, as explained in section 3.2. 

2.3. Status bar 

Status bar is at the bottom line of the main application window. It is used for displaying 

information like license expiration and number of days since last backup. 

 

2.4. Patients Tab 

Upper region of Patients Tab contains selected patient’s data and buttons for Uploading 

patient’s photo, adding new patient, and saving and deleting selected patient record. Lower 

region contains table initially displaying all patients sorted by their Surname. 
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2.4.1. Sorting and filtering 

Patient records could be sorted by country, ID and Surname or any combination of these. 

Sorting is performed by clicking header of corresponding table column. Clicking the same 

column again reverses sort order. To sort e.g. first by country and then by ID click Country 

column and then click Patient ID column holding <Shift> key. 

Patient records could be filtered by ID and surname by entering first few characters of either 

ID or patient’s surname. 

2.4.2. Add new patient 

Since the database is initially empty, first operation will be adding new patient record. Click 

Add New Patient button. Upper part of the Patient Overview tab will look like this: 

 

Country field will be automatically selected from Windows regional settings, which means 

that selected country will usually be the one you reside in. Cursor will be positioned at 

PatientID field, which should be unique within the particular country. If patient with the 

same ID already exists inside the database, application will offer to open that patient.  

You could enter other available information. Date 

fields (like D.O.B.) reflects regional settings for 

displaying and entering dates. Date could be 

entered by typing it directly into the field in 

appropriate format, or it could be selected 

through the date picker, activated by clicking at 

the  icon right to the field. 

Navigation with the date picker is easy. A left and right arrow at the heading moves to 

previous and following period (indicated by the heading). Initially period is one month, which 

could be changed by clicking at the heading. First click changes period to the year, second 

click to the decade. 
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All data are kept in memory until saved. You could save data at any moment by issuing Save 

command on any tabs, or by clicking  button at the toolbar. Any Save command will 

save all unsaved data to the database. Application will offer to save data if there are unsaved 

data and you try to create or open another patient or try to exit the application. 

Added patient will be displayed in the patients table only when saved, since that table 

displays only data physically stored to the database. 

2.4.3. Open patient 

Patient is opened by clicking appropriate row at the patients table. By double clicking the 

patient’s row you will be directed directly to Wounds or Examinations tab, depending on 

information exists. 

When the mouse cursor is positioned above the patients table you could use the mouse 

wheel to quickly navigate through patient records. 

2.4.4. Delete patient 

Patient record could be deleted from the database by clicking at the Delete Patient 

button. Precaution is required because patient record and all related wounds and 

examinations records will be physically deleted from the database. Only possibility 

to restore deleted data is through the backup copy of the database, if such exists. 

For that reason application warns you and asks for deletion confirmation. 

2.5. Print patient report 

Tool bar Print button ( ) generates patient report, containing basic patient’s data, 

tabular information about all examinations and healing progress graphs. Report is generated 

in compact form, i.e. data fields that are not filled are completely left out of the report, 

including the label. 

Using toolbar at the bottom of the preview pane it is possible to search the report for 

particular word or phrase, change the view to page, two page or scroll (default), zoom the 

preview and print report. 
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2.6. Wounds Tab 

Initially Wound Overview Tab has only one control enabled – Add New Wound button. 

After pressing the Add New Wound button new blank row appears in the wounds table. 

Although not required, it is strongly recommended to define wound type and location. Click 

at the corresponding field opens list of choices from which appropriate type and location 

should be selected. If known, the wound formation date could be entered. In that case 

wound age is automatically calculated. If the Wound Healed checkbox is selected, wound 

and all examinations are locked and treatment period is calculated. 
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Save button will save all unsaved data. Delete Wound will delete all wound 

and related examinations data so it should be used with precautions. 

2.7. Examinations Tab 

Examinations Tab has four sub-tabs, discussed in following chapters. 

2.7.1. Examination Overview Tab 

Initially Examinations Overview Tab has only one control enabled – Add New 

Examination button. In case that button is disabled, check if wound exists for the given 

patient, because examination could be created only if corresponding wound exists. 

After pressing the Add New Examination button new row appears in the examinations 

table. Examination date is initially set to the today’s date. Examination date could be 

changed through the corresponding date picker field. 
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To be able to analyze the wound, wound photo should be uploaded into the application 

using the Upload Photo button. It opens standard Windows file manager window where 

it is possible to select desired image. Wound images should be in JPEG format. 

Examination Overview Tab with multiple examinations is much more informative. 

Examination date, notes and image for the selected examination are displayed. If analysis 

was performed it is possible to display resultant image over the wound image, where 

transparency could be adjusted with the slider below the image. Quick navigation is possible 

with the mouse wheel, if mouse cursor is either over the wound image or over the 

examinations table. 

Examinations table provides basic information about examinations. Day column displays 

number of days from first examination. Tissues column gives quick overview of the wound 

status, graphically and numerically displaying percentages of different tissue types. Area 

column displays wound area and WHR column wound healing rate, which is calculate as 

relative weekly change of wound area. 
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2.7.2. Wound Analysis Tab 

Wound analysis tab is the most complex part of the application and will be explained in 

chapter 3. 

2.7.3. Wound Assessment Tab 

At this tab result of the wound analysis for the selected examination is presented graphically 

and numerically, containing of percentages of different tissue types within the wound and 

wound dimensions (area and circumference). 
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2.7.4. Healing Progress Tab 

Healing progress tab summarizes wound analysis during whole treatment. Data for particular 

examination is displayed at corresponding day point from the beginning of treatment. Upper 

graph presents change of tissue percentages in time and lower one change of wound area 

with tissue content. 

 

 

2.8. Print examination report 

If Examinations tab is selected tool bar Print button ( ) generates examination report, 

containing detailed data of selected examination, including wound and resultant image. 

Report is generated in compact form, i.e. data fields that are not filled are completely left 

out of the report, including the label. 
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3. WOUND IMAGE ANALYSIS 

3.1. Image Analysis Principles 

Core of the WoundManagerTM application is specially developed digital image analysis 

algorithm based on artificial intelligence. It learns from medical doctor – expert for chronic 

wounds. On selected set of wound photographs wound expert manually marked particular 

tissue types. Generated training data was used to train the classifier. Maximal classification 

error is 5% for reasonable quality photographs (sharp photograph with good color 

reproduction)1. 

3.1.1. Four tissue types – Why? 

Normally clinicians deals with three usual tissue types: fibrin, granulation and necrosis. We 

introduced additional tissue type: fibrin layer, which basically consists of thin fibrin layer 

covering granulation tissue. Normally such a tissue is considered as fibrin. 

Separate treatment of the fibrin layer assisted in improved classification accuracy, because it 

is otherwise difficult to distinguish reddish color of fibrin layer from normal granulation 

tissue. Separate treatment of the fibrin layer makes sense in medical terms too, because 

such tissue will turn into granulation quicker than pure fibrin tissue. 

Through the Tools->Options command it is possible to select whether four tissues will be 

used or analysis will be based on classical three tissue types. In that case fibrin and fibrin 

layer are displayed simply as fibrin. 

3.1.2. Epithelization 

Often islands of epithelization are formed within granulation tissue. Current version of image 

analysis algorithm is not able to distinguish epithelization from fibrin tissue and therefore 

manual method of selecting epithelization islands is implemented (see 3.2.4). 

3.2. Wound Analysis Tab 

Majority of the wound analysis tab is dedicated to wound image display.  

When the tab is active, six additional icons are displayed inside the toolbar at the top of the 

screen: 

                                                      
1
 D. Huljev, Chronic wound tissue characterization based on digital wound photography, Ph.D. thesis, University 

of Zagreb, School of Medicine, 2011. (in Croatian) 
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 Calibrate button  for image calibration, 

 Mask button  for defining wound region, 

 Epithelization button  for defining regions of epithelization, 

 Analyze button  for starting wound analysis 

 Show/hide button  for showing and hiding results 

 Adjust button  for adjusting classifier. 

 

3.2.1. Zoom image region 

 Default action when no other command is selected is 

to zoom image in and out. E.g. to zoom the ruler 

displayed at the right image, position mouse cursor to 

the top left corner of area of interest, press left button, 
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drag the mouse cursor to the bottom right corner and release the button.  

To display image in original size (fit to window) just click the right mouse button anywhere at 

the image. 

3.2.2. Calibrate image 

To determine absolute wound dimensions it is necessary 

to calibrate the image, which is performed by marking 

distance of 1 cm, requiring that the ruler with centimeter 

scale be photographed near the wound. Click 

Calibrate button , then click at the first point of 1 

cm line, release the mouse button and finish calibration 

by clicking the second point. Marked distance is shown by 

blue line. 

If there is no ruler at the wound image you may skip the calibration step. In that case wound 

dimensions will not be calculated and you will get only percentage of tissue types. 

3.2.3. Marking wound borders 

It is necessary to manually draw mask around the wound area. Zoom to the wound area as 

described in 3.2.1 and click Create mask button . Button remains pressed and 

mouse cursor changes to the pencil. Start drawing the mask by left clicking at the starting 

point anywhere at the wound border. There is couple of options how to draw the mask: 

 To draw straight line segment, release the left button, move the mouse pointer to 

the next point and left click to mark that point. 

 To draw curved segment, keep left button pressed while moving the mouse pointer. 

Release the left button to finish the curved segment. 

 To delete last segment, press the right mouse button (you could repeat that action). 

 To finish drawing the mask, double click at the last point, which should be near the 

beginning point. 

3.2.4. Marking epithelization regions 

Procedure of marking epithelization regions is similar to marking wound border. Difference 

is that it is possible to mark multiple epithelization regions. Closing current region by double 

clicking the last point did not exit the command and the next region could be marked. 

Therefore it is necessary to exit the command by clicking the Epithelization button  

again. 
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Switching Epithelization button on and then off without drawing any epithelization segment 

will remove epithelization marking. 

 

 

3.2.5. Wound Analysis 

To analyze the wound click the Analyze button . After few seconds, depending on 

image size and computer speed, analysis will finish and resulting image will be displayed 

over the wound image. Granulation tissue is displayed red, fibrin layer covering granulation 

tissue pink, fibrin yellow, necrotic tissue gray and unknown tissue blue.  

At the resultant image there is couple of blue spots of unclassified tissue caused by flash 

reflections.  
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Resultant image could be displayed over original wound image or hidden by pressing the 

Show/hide button .  

Tissue classification is not perfect. It is influenced by photographing conditions, especially by 

illumination. At the above example some dark spots are misclassified as necrotic tissue, 

which is not present in the particular wound. To correct such issues it is possible to manually 

adjust classification parameters using Adjust command . Since manual adjustments 

influence objectivity, that option is intended only for an expert knowing how to properly 

adjust classifier, and only in case of poor quality image where manual adjustments will 

improve quality of the analysis.  

To enable adjustment it is necessary to perform fresh image analysis, even if results of 

previous analysis exist. Clicking Adjust button ( ) opens form for tissue classifier 

adjustment: 
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Two panels at the left present original wound image and resultant image in pseudocolors. To 

simplify adjustments, boundaries between different tissues are superimposed to the original 

wound image. G and N sliders are used to increase or decrease granulation and necrotic 

tissue relative to other surrounding tissue types. Pressing OK button will close the 

adjustment form and perform analysis with adjusted parameters. 
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4. CONTACT 

You are encouraged to provide feedback about usability of the product, features you wish to 

see implemented into the next version, bugs (log file WMBasicLog.txt will be created at 

the user desktop if application crashed, please send it to us), and any other inquiry. 

 

E-mail:  WMinfo@antonic.hr 

Web:  http://www.woundmanager.com/ 
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